Let’s Frame It Up

Assemble the Main Body Frame

Note: Advisable to complete all the assembly related to the Vertical Frames before attaching the Top Frame
Bottom Vertex = 1 pc

M3 x 8mm Cap Screw = 10 pcs

M3 Nut = 10 pcs

Prepare Parts

Parts required for a single Bottom Vertex assembly

Please notice: we have changed the nuts to this one specially for 2020 aluminum
Attach all 10 pcs of M3x8mm Cap Screws and M3 Nuts to the Bottom Vertex as shown above.
Repeat steps {C01} to {C02}. Total 3 sets of assembled Bottom Vetexes needed as shown above.
[Prepare Parts]

Parts required for Bottom Frame Vertex assembly

Assembled Bottom Vertex = 1 set

OpenBeam 240mm = 2 pcs
Align the M3 Nuts at one side of the Bottom Vertex assembly to the opening of OpenBeam slot guide and slot them in all the way to the end.
Fasten both OpenBeams which are in correct position by tightening the M3 Cap Screws as shown above.
Repeat steps {C04} to {C06}. Total 3 sets of assembled Bottom Frame Vertexes needed as shown above.
Assembled Bottom Frame Vertex = 3 sets

[Prepare Parts]

Parts required for Bottom Frame assembly
Align and Slot In

Align the M3 Nuts at the opened side of the assembled Bottom Frame Vertexes to the opening of OpenBeam slot guide and slot them in all the way to the end.
Tighten the Screws

Fasten the newly slotted in OpenBeams which are in correct position by tightening the M3 Cap Screws as shown above.

[Tools]
M3 Allen Key
[Inspection]

Place the completed Bottom Frame on flat surface and make sure the bottom part is perfectly even
Parts required for Top Vertex assembly

- Top Vertex = 1 pc
- M3 x 8mm Cap Screw = 5 pcs
- M3 Nut = 5 pcs
Attach all 5 pcs of M3x8mm Cap Screws and M3 Nuts to the Top Vertex as shown above.
Parts required for Top Vertex Belt Idler assembly. Layout in proper assembly arrangement

- M3x25mm Cap Screw = 1 pc
- F623ZZ Flanged Bearing = 2 pcs
- M3 Washer = 4 pcs
- M3 Nut = 1 pc

Assembled Top Vertex = 1 set

Note: M3 washer not needed now.
Attach M3 Nut, M3 Washers and Flanged Bearings as arranged in {C14} and fasten them to the assembled Top Vertex by tightening the M3x25mm Cap Screw as shown above.
Repeat steps {C12} to {C15}. Total 3 sets of assembled Top Vertexes with Belt Idlers needed as shown above.
Prepare Parts

Parts required for Top Frame Vertex assembly.

OpenBeam 240mm = 1 pc
Assembled Top Vertex with Belt Idler = 1 set
Align the M3 Nuts at one side of the assembled Top Vertex to the opening of OpenBeam slot guide and slot them in all the way to the end.
Fasten both OpenBeams which are in correct position by tightening the M3 Cap Screws as shown above.
Repeat steps {C17} to {C19}. Total 3 sets of assembled Top Frame Vertexes needed as shown above.
Prepares Parts

Parts required for Top Frame assembly

Assembled Top Frame Vertex = 3 sets
Align the M3 Nuts at the opened side of the assembled Top Frame Vertexes to the opening of OpenBeam slot guide and slot them in all the way to the end.
Fasten the newly slotted in OpenBeams which are in correct position by tightening the M3 Cap Screws as shown above.
[Inspection]

Place the completed Top Frame on top of the Bottom Frame and make sure they are perfectly aligned at the vertex points and as well as the edges
Assembled Bottom Frame = 1 pc

OpenBeam 600mm = 3 pcs

Parts required for Vertical Frame assembly
Align the OpenBeam Vertical Frame slot guide to the M3 Nuts inside one of the assembled Bottom Frame Vertex’s vertical frame opening and slot it in all the way to the end.

*note: very tight is correct, so later it would be stable. Can use some tools to grind it a little bit*
Once the OpenBeam Vertical Frame fully slotted in, secure it by tightening the M3 Cap Screws as shown above.
Repeat steps \{C26\} to \{C27\}. Total 3 Vertical Frames assembly needed as shown above.
then put on the top like this way
Let’s Move It
Assemble the Moving Parts
[Prepare Parts]

Parts required for Stepper Motor Assembly

- NEMA17 Stepper Motor = 1 pc
- GT2 Aluminium 16 Teeth Pulley = 1 pc
- Set Screw = 2 pcs
Attach the GT2 Pulley to the Stepper Motor shaft and tighten the Set Screw as shown above.
Repeat Steps {D01} to {D02}. Total 3 sets of Stepper Motor assembly needed as shown above.
Prepare Parts

Parts required for Vertical Linear Motion Stepper Motor mounting to the assembled Main Body Frame

- Assembled Main Body Frame = 1 set
- Assembled Stepper Motor = 3 sets
- M3x8mm Cap Screw = 12 pcs
Mount the assembled Stepper Motor to the Bottom Vertex and tighten the M3x8mm Cap Screws (4pcs) as shown above.
Repeat Steps {D05}. Total 3 sets of Vertical Linear Motion Stepper Motors needed as shown above.
Effector = 1 pc

M3 Nylon Lock Nuts = 6 pcs

Parts required for Effector assembly
Thread the M3x25mm Cap Screw thru the ball joint mounting hole and attach an M3 Nylon Lock Nut as shown above.
Repeat Steps \{D16\} to \{D17\}. The completed Effector assembly is as shown above.
Ignore this parts first, later you can put on the Hotend directly as this picture.

M3x25mm Cap Screw = 1 pc

Assembled Push Rod = 1 set

Assembled Effector = 1 set

[Prepare Parts]

Parts required for Effector & Push Rod assembly
Thread the M3x25mm Cap Screw into the Push Rod Ball Joint as shown above
Attach the Push Rod to Effector assembly and tighten the M3x25mm Cap Screw as shown above.
Repeat Steps {D22} to {D24}. The completed assembly should have all 6 sets of Push Rods attached to the Effector as shown above.
M3x20mm Cap Screw = 6 pcs

[Prepare Parts]

Parts required for Push Rod to Vertical Carriage assembly
Locate these parts!

1. Roller Carriage Plastic Printed Part x 3
2. POM Roller Wheel with 696ZZ Bearing x 9
3. M3 * 10mm screw x 6
4. M3 * 25mm screw x 3
5. M3 nut x 9
6. M6 * 25mm screw x 9
7. M6 nut x 9

Vertical Carriage + Wheel assembling, and then put it on Openbeam.
and then Assemble them:
Open Ended GT2 Belt 1300mm = 1 pc

[Prepare Parts]

Parts required for Vertical Linear Motion Drive Belt assembly.
Note: 4000mm Open Ended GT2 Belt supplied in the kit. Cut it into 3 pcs.
Loop the GT2 Belt over the Belt Idler’s Flanged Bearing, and pull it downwards. Then loop it over the GT2 Pulley and pull it upward as shown above. The Vertical Carriage should stays anchored during pulling actions.
after Belt done, Connect Vertical Carriage (with Wheels) + Rods + Effector, and then it will look like this.
find Endstops (3) and Plastics (3)
put them onto each 2020 Openbeam as shown below

remember to put plastic parts between endstop & openbeam to insulate them
Assemble the Spool holder

find these parts first
Assemble them as below
put them on as below
then later when you get the filament you can adjust the position to fix it
now put on the extruder holder as well as extruder
Congratulations! it’s done!
[Prepare Parts]

Parts required for Auto Level Probe Microswitch assembly.

Endstop Wires = 1 pair

Endstop Microswitch = 1 pc
Solder the marked wire to the “C” (or “COM”) terminal and the other wire to the “NO” (or “Normally Opened”) terminal as shown above.
[Preparations]

Bend the Microswitch terminals using Long Nose Pliers as shown above. Trim the Microswitch metal lever to 7mm using Metal Cutter as shown above.
Mount the prepared Auto Level Probe Microswitch to the Auto Level Probe Holder and tighten the M2.5x12mm Cap Screws as shown above.

For more pictures about how to assemble the hotend, please check pictures here: https://www.dropbox.com/sh/1wf49y09azud2n4/AABUgy-f3DX-n-PNjz3J2fCEa?dl=0
[Prepare Parts]

Parts required for Auto Level Probe Docking Latch assembly.

M2.5x12mm Cap Screw = 1 pc
Safety Needle 2.5mm Diameter = 1 pc

[Tools]
Long Nose Pliers & Metal Cutter
Mount the Auto Level Probe Docking Latch assembly to the Auto Level Probe Holder as shown above. Gently tighten the M2.5x12mm Cap Screw just enough to hold the modified Safety Pin in position.
[Prepare Parts]

Parts required for Auto Level Probe assembly.

- 1.5mm Allen Key = 1 pc
- 23.5mm Compression Spring = 1 pc
- Terminal Block = 1 pc

It’s printed by plastic now
Slot in the M1.5 Allen Key and dock it at retracted position as shown above.
Thread the M1.5 Allen Key thru the 23.5mm Compression Spring then followed by the Terminal Block. Fully compress the spring and tighten both screws in Terminal Block as shown above.
[Inspections]

Left: Auto Level Probe in deployed position. Probe tip must be lower than the Hot End nozzle tip. Right: Auto Level Probe in Retracted position. Probe tip must be higher than the Hot End nozzle tip.
When Auto Level Probe in Retracted position, Probe tip must be higher than the Hot End nozzle tip.
Lay the Glass Bed on top of the Bottom Frame. Tighten all 3 fasteners once the Glass Bed is centered properly. Make sure Glass Bed is firmly secured before print.
Slot the Auto Level Probe Retractor into the rail guide at X-Z Edge. Tighten the M3x20mm Cap Screw once in position as shown above.
Let’s Wire It Up

Controller Board and Wirings
[Prepare Parts]

Parts required for Controller Board Assembly as shown above.

- Arduino Mega2560 = 1 pc
- RAMPS 1.4 = 1 pc
- Stepper Driver = 4 pcs
- Jumper = 12 pcs
Fully slot in the RAMP1.4 board on top of the Arduino Mega2560 Controller Board as shown above.
[Assemble]

Slot in 3 pcs of Jumpers per Stepper Motor slot in RAMPS1.4 board as shown above. Total 12 pcs of Jumpers needed
Slot in 4 pcs of Stepper Driver to RAMPS1.4 board as shown above.

**Assemble**

notice: the stepper must be placed correctly, otherwise it would burn all parts.

tip: better to put one and test, then add one by one, because stepper is easy to have short circuit. Therefore, you can check one after one.
Assembled Controller Board
= 1 set

M3x35mm Cap Screw = 2 pcs

M3 Nut = 4 pcs
Thread M3x35mm Cap Screws thru the boards’ screw holes, then follow by M3 Nuts as shown above.
Attach the assembled Controller Board at X-Z Edge of Top Frame thru the OpenBeam slot guide opening, then tighten the 2 pcs of M3x35mm Cap Screws as shown above.

note: you can put it anywhere along with aluminum 2020 extruder there’s no need to be the same.
for motors, please ignore the colors, just plug and use. if it’s running the wrong direction, then just reverse the plug. and it will go to the opposite direction.
Let’s Power It Up

Power On and Connect to PC

Note: LCD Controller Board is for illustration purpose only. This Guide will use Computer Software & USB Connection to operate the Kossel Mini.

Note: you can put it anywhere along with aluminum 2020 extruder there’s no need to be the same.
[Measure]

Detach the power terminal from Controller Board and measure the DC Power Supply as shown above. If terminated correctly, the voltage and polarity should be around +12V !!!Wrong polarity will cause permanent damage to the Controller Board!!!
Reconnect the power terminal to the Controller Board as per {E08} and switch on the power supply. Once the Controller Board is powered on properly, the LED Indicator should light up as shown.
Make sure FAN is operating ALL THE TIME when Controller Board is powered on. Also, verify that the FAN airflow is orientated correctly as shown in {D62}. ***Continuous cooling is essential to prevent Hotend Jamming or Effector meltdown!!!***
This Guide will use the following Software & Firmware Package for Kossel Mini.

For Mac User [http://www.blomker.com/KosselMini_Mac.zip]

Alternatively, you can check for any latest updates in the future and download them individually if needed:

Printrun-Pronterface [http://koti.kapsi.fi/~kliment/printrun]
Slic3r [http://slic3r.org/download]
jcrocholl Marlin [https://github.com/jcrocholl/Marlin]

Download the required Software and Firmware Package to the Computer and extract the .zip file

notice: we will send another email for the latest firmware
This Guide will use Software and Firmware setup as shown above to calibrate/fine-tune/operate the Kossel Mini and eventually, first test print.
Install Arduino Software in the Computer by executing the .exe file. Once completed, connect the Computer to Kossel Mini USB port. Verify the COM Port Number assigned for Arduino Mega 2560 (eg. COM34) as shown above.
Run file [Blomker KM File/Marlin_delta2/Marlin_delta2.ino]. Go to Tools->Board, select Arduino Mega 2560 as shown above. In case you have been following exactly our build instructions from Part {A} to {E}, this Marlin_delta2 Sketch will instantly enable your Kossel Mini for Part {G} verifications, and then followed by calibration and first test print.

note: better to use older arduino IDE 1.0.5 version. latest version is possible to have library problem such as with time.h error
Go to Tools -> Serial Port, select the COM Port as per assigned in Step {F06}.
Click the “Upload” button to upload the Marlin_delta2 Firmware Sketch to Kossel Mini Controller Board. Once upload successful, message “Done Uploading” will be displayed.
Locate and run file [pronterface.exe] extracted during {F04}. Set COM Port as per assigned in Step {F06}, and Baud Rate to 250000, then click “Connect”. Once connection successful, messages will be shown as above. Ignore message “SD init fail” as LCD Controller Board with SD Card not available.
Let’s Check It Out
Verify Kossel Mini Setup using Pronterface

Note: Verifications needed to ensure Kossel Mini has no wiring or hardware issues. Verification result is based on the Marlin_delta2 firmware uploaded to Kossel Mini during {F10}. 
[G01]

[Verify Endstops & Auto Level Probe Status]

[MCODE] M119

[Sample Output]

>>>M119
SENDING:M119
Reporting endstop status
x_max: open
y_max: open
z_min: TRIGGERED
z_max: open

[Observation: x_max, y_max, z_max]
Carriage in contact with Endstop Switch => "TRIGGERED"
Carriage NOT in contact with Endstop Switch => "open"

[Observation: z_min]
Auto Level Probe in contact with Switch (Deployed) => "open"
Auto Level Probe NOT in contact with Switch (Retracted) =>"TRIGGERED"
[G02]

[Verify Nozzle/XYZ Carriages Homing]

[GCODE] G28 or [GUI]

[Observation: Nozzle/XYZ Carriages Movements]

All XYZ Carriages will travel towards respective Endstops and slightly back off after in contact with respective Endstop switch.

[Important Note]

Nozzle/Carriage Homing also means to park the Nozzle tip at Cartesian Coordinate \([0,0, \text{MANUAL}_Z\_\text{HOME}\_\text{POS}]\). In this case, \([0,0,239]\)

After Power Cycle or Reset, Controller Board will lost track of Nozzle’s Cartesian Coordinates/Carriages’ position. It is essential to send GCODE [G28] or using GUI “HOME” button to update again current Nozzle coordinates.
{G03}

[Verify Current Coordinates/Position]

[M CODE] M114

[Sample Output]
SENDING:M114
X:0.00Y:0.00Z:239.00E:0.00 Count X: 425.52Y:425.52Z:425.52

[Observation: X:0.00Y:0.00Z:239]
Indicate the current Cartesian coordinates of Nozzle Tip when HOME.
"Z:239" corresponds to "#define MANUAL_Z_HOME_POS 239" in
[Configuration.h] of Marlin_delta2. This info will be referred during Calibration

[Observation: Count X: 425.52Y:425.52Z:425.52]
Indicate the current linear position of Carriages on their respective Towers

[Important Note]
If output is "X:0.00Y:0.00Z:0.00E:0.00 Count X: 0.00Y:0.00Z:0.00",
Controller Board have lost track of positions. Need to home all Axis again.
[Verify Extruder Motor Extrude and Reverse Motion]

[MCODE] M302 and [GUI]

[Observation: Extruder Motor Drive Gear Rotation]

After sending MCODE [M302], verify Extruder Motor Drive Gear Rotation as below:
Extrude => Clockwise Rotation
Reverse => Counter Clockwise Rotation

[Important Note]

"#define EXTRUDE_MINTEMP 170" will prevent Extruder Motor from any motions when Nozzle temperature is below 170C. Hence, MCODE [M302] needed to enable cold extrusion before this verification is possible
[Verify Hotend Temperature]

Select 185 (PLA) and click “Set”. Verify that temperature is sustainable (at least 15mins) after reaching 185°C. Then follow by similar verification for 230°C. In case failed to attain target temperature after continuous heating:

1. Make sure the FAN airflow not directed to Hotend’s heat block {D62}
2. Make sure Heater and Thermistor wires terminated properly {E08}

[Important Note]

Before proceed for Hotend Temperature verification, ensure step {F03} already verified. At this stage, do not leave the Hotend unattended during Temperature verifications, especially when heating above 185°C. Click “Off” to cancel heating of Hotend once Temperature verification completed.

[Observation: Hotend Target Temperature Sustainable]

[Observation: No Overheating at Effector]

Continuous cooling by the FAN airflow should keep the Effector (PLA material) below 100°C.
Let’s Calibrate

Calibration and Fine-Tuning

Note: There will be no identical Kossel Mini units. The provided Marlin_delta2 Firmware contains calibrated settings for a working unit built by Blomker Industries. It will be more on fine tuning the values to match your built unit if you are using Marlin_delta2 Firmware.
To calibrate a Delta Printer like Kossel Mini, it is essential to distinguish XYZ Axes from XYZ Towers. In essence, Delta Printer makes coordinated movements of XYZ Carriages on their respective Towers, which will translate to movement of Nozzle (Print Head) in Cylindrical/Cartesian print space, consist of XYZ Axes and Coordinates.
Unit of XYZ Coordinates are in [mm].

Boundaries/Radius of the Cartesian print space are specified by Min & Max parameters of XYZ Axes in [Configuration.h] of Marlin_delta2 Firmware.

Two key Coordinates needed during Calibrations are the HOME Coordinate [0,0,Zmax] and Center of Bed [0,0,0].
Nozzle movements are controlled by means of sending GCODE G1 + XYZ Coordinates (in mm), or using GUI + Distance of Movement (in mm).

For GUI method, minus (-) sign meaning to move towards Min direction of the Axis. As for GCODE, it represents the negative coordinates (<0), which in this case, we will only have positive and negative X or Y coordinates. Z Axis will only have positive coordinates (>0)
If initial position of Nozzle is at HOME position, illustrations above demonstrate the difference between movement by GUI + Distance of Movement and GCODE + Coordinates. Good understanding and combo usage of both methods can help to shorten calibration time, especially during Z-Axis and Bed Auto Leveling Calibration.
Delta Kinematics is the algorithm in firmware which translates XY Coordinates in the Cartesian plane to the required linear positions of XYZ Carriages on respective Towers. The key dimensions below in [Configuration.h] are required by the Delta Kinematics for accurate representation of the Nozzle position in XY plane. Send GCODE G28 to home the XYZ Carriages before taking measurement from the as built unit.

// Center-to-center distance of the holes in the diagonal push rods.
#define DELTA_DIAGONAL_ROD 213.5 // mm (215)

// Horizontal offset from middle of printer to smooth rod center.
#define DELTA_SMOOTH_ROD_OFFSET 136.5 // mm (137.0)

// Horizontal offset of the universal joints on the end effector.
#define DELTA_EFFECTOR_OFFSET 20 // mm (19.9)

// Horizontal offset of the universal joints on the carriages.
#define DELTA_CARRIAGE_OFFSET 12.0 // mm (19.5)
Conversions from number of steps to distances travelled in mm are defined in [Configuration.h] as shown above.

For more info, kindly refer to the wonderful RepRap Calculator tool shared by Josef Prusa [http://calculator.josefprusa.cz]

Please note that Extruder Motor is using a different Drive Gear than XYZ Motors
Print Height/Print Bed Centre Calibration procedures using Pronterface are as below:

1. Send GCODE G28 to home the Nozzle
2. Send MCODE M114 to check Z Height at HOME position. Z:239 corresponds to MANUAL_Z_HOME_POS 239 in [Configuration.h]
3. Send GCODE G1 Z10 to move the Nozzle close to the Print Bed
4. Use GUI to move nozzle 1mm towards Print Bed
5. Repeat 4 till gap between Nozzle and Print Bed less than 1mm
6. Repeat 4 but move 0.1mm towards Print Bed
7. Repeat 6 till Nozzle is 0.1mm above Print Bed. This Nozzle position will be defined as Print Bed Centre [0,0,0]
8. Send GCODE M114 to check the current Z value.
9. New MANUAL_Z_HOME_POS value = Old MANUAL_Z_HOME_POS value – current Z value. This new value will defined the Max Print Height.
10. Update #define MANUAL_Z_HOME_POS __?__ with the new value. Then reupload the updated Marlin_delta2 firmware using step {F09}
11. If 7 is not possible, software Endstop limit reached. Update value in [Configuration.h] #define min_software_endstops false and repeat Step {F09}. Kindly disconnect Pronterface before attempting Step {F09}
12. Repeat 1 to 7. Once completed, then Repeat 11 with value true.
GCODE G29 consist a set of continuous procedures which eventually align Nozzle to move at uniform Z Height above a flat Print Bed.

After sending GCODE G29, 3 procedures as below will be automatically executed:

1. Deploy Z Probe
2. Probe Print Bed (at 37 Locations)
3. Retract Z Probe

Below is the snapshot of G29 main codes found in [Marlin_main.cpp]:

```c
case 29: // G29 Calibrate print surface with automatic Z probe.
  saved_feedrate = feedrate;
  saved_feedmultiply = feedmultiply;
  feedmultiply = 100;

  deploy_z_probe();
  calibrate_print_surface(z_probe_offset[Z_AXIS] +
    (code_seen(axis_codes[Z_AXIS]) ? code_value() : 0.0));
  retract_z_probe();

  feedrate = saved_feedrate;
  feedmultiply = saved_feedmultiply;
  previous_millis_cmd = millis();
  endstops_hit_on_purpose();
  break;
```
The default Z Probe deployment mechanism is by pushing the horizontal portion of Z Probe against the GT2 belt of Z-Tower. The XYZ coordinates shown below is where the pushing of Z Probe (in –X direction) against GT2 belt will begin from.

Our recommendation is to deploy the Z Probe manually by hand, then follow by sending GCODE G28 before sending GCODE G29. This will eliminate the need to extend the horizontal portion of the Z Probe (using extra materials), and also reduce the risk of accidental deployment of Z Probe during printing at certain locations.

Manual Z Probe deployment by hand will not affect the Probing and Retraction of Z Probe in later stage of GCODE G29 procedures.

In case the auto Z Probe deployment method is preferred, make sure the XYZ coordinates is suitable for your built and horizontal portion of Z Probe is extended.
By default, the deployed Z Probe will probe the Print Bed at 37 locations. The exact probe locations are determined by 2 parameters in [Configuration.h]:

**#define AUTOLEVEL_GRID 26**

This parameter indicates the Distance between autolevel Z probing points, and should be less than print surface radius/3.

In Marlin_delta2 firmware, value 26 is chosen due to:

1. Print Radius (Xmax, Xmin, Ymax, Ymin POS) defined is 85mm.

2. Considering that value higher than 26 might cause collision of Effector platform/Fan with X & Y Towers’ GT2 Belt during probing stage.
This parameter indicates Distance between Nozzle and the deployed Z Probe’s tip. By placing Z Probe Holder as per {D58}, the X-Offset value is always “0”. The X and Y Offset values will be used by firmware to direct the Z Probe tip (using GCODE G1) to the 37 probing locations. As for Z Offset, repeat fine-tuning needed to make sure Nozzle position at [0,0,0] is the same before and after GCODE G29 procedures.

Actual GCODE for 1st Probe Point:
G1 X26 Y64

Actual GCODE for Last Probe Point:
G1 -X26 -Y82

Y Offset: 14mm
Z Offset: -6.7mm
The Z Probe retraction mechanism involves moving the Z Probe’s tip above the Retraction Cap Screw (installed in step {D90}), and then lifts the Z Probe to docking position in the Probe Holder by pushing the tip vertically against the stationary Cap Screw. The related parameters to be fine-tune according to your built are as below:

```c
void retract_z_probe() {
    feedrate = homing_feedrate[X_AXIS];
    destination[Z_AXIS] = current_position[Z_AXIS] + 20;
    prepare_move_raw();

    destination[X_AXIS] = -60.0;
    destination[Y_AXIS] = 63.5;
    destination[Z_AXIS] = 30;
    prepare_move_raw();

    // Move the nozzle below the print surface to push the probe up.
    feedrate = homing_feedrate[Z_AXIS]/10;
    destination[Z_AXIS] = current_position[Z_AXIS] - 19;
    prepare_move_raw();

    feedrate = homing_feedrate[Z_AXIS];
    destination[Z_AXIS] = current_position[Z_AXIS] + 29;
    prepare_move_raw();
    st_synchronize();
}
```

The X & Y Coordinates indicates the position to place the Z Probe’s Tip before retraction. Leave the Z Coordinate unchanged at 30.

Indicates the distance of downward vertical movements needed to lift the Z Probe. After Z Probe at docking position, Nozzle will be lifted to 40mm above Print Bed. If modification needed to match your built, ensure that their absolute value difference is +10. Eg. 29 - 19 = +10
G29 or Auto Bed Leveling Calibration procedures using Pronterface are as below:

1. Deploy Z Probe manually by hand. Send MCODE M119 to verify "Z_min: open"
2. Send GCODE G28 to nullify any position errors introduced by 1.
3. Send GCODE G29 to start the Auto Bed Leveling procedures.
4. Once completed probing at the Last Probing Point (shown in {H10}), Z Probe retraction procedure will begin by moving to coordinates specified in {H12}
5. In case Z Probe’s tip not position above the Retraction Cap Screw, quickly use your fingertip as a support to allow lifting of Z Probe to docking position.
6. Once G29 procedures completed (idling), redeploy the Z Probe manually by hand again.
7. Use Pronterface GUI to move the Z Probe’s tip right above the Cap Screw. Once in position, send MCODE 114 and record down the X & Y coordinates.
8. Use Pronterface GUI to move Z Probe vertically downward in 1mm steps till the Z Probe being lifted back into docking position. Send MCODE 114 and record down the Z coordinate.
9. If needed, updates X and Y coordinates in {H12} as per value obtained in 7.
10. If needed, updates value “19” to New Value1 using equation as follow
    New Value1 = 30 - Value obtained in 8
11. If New Value1 updated in step 10, updates value “29” to New Value2 as follow
   New Value2 = New Value1 + 10.
12. If values in 9 to 11 are updated in Marlin_delta2 firmware, reupload the
    firmware using step {F10}. Remember to disconnect Pronterface before {F10}
13. Once upload is successful, Controller Board will be reset automatically and the
    Print Bed interpolation/offset data stored during last GCODE G29 procedures
    will be cleared.
14. Repeat 1 to 13 until Z Probe is retracted properly without user intervention.
15. Send MCODE M114 to verify that Z Coordinate is 40 (40mm above Print Bed)
16. Send GCODE G1 X0 Y0 to center the Nozzle.
17. Use GUI to move Nozzle gradually towards center of Print Bed [0,0,0], same as
    the Nozzle position determined during {H06} Step 7.
18. Send MCODE M114 to verify if Z value is zero (“0”). If yes, G29 Calibration
    completed.
19. If step 17 is not achievable, or Z Value obtained in step 18 greater than “0”,
    reduce the Z Value in [#define Z_PROBE_OFFSET {0, 14, -6.7, 0}, eg, to -6.9,
    or vice versa, then follow by reupload of firmware as per step {F10}
20. Repeat 1 to 19 till Nozzle position at [0,0,0] is the same before & after G29
    procedures.
Once completed steps {H05} to {H14}, perform verifications as follow using Pronterface:

1. Move Nozzle to 0.4mm above centre of Print Bed \([0,0,0.4]\)
2. Move Nozzle to XY Plane Print Boundaries at Coordinates \([85,0,0.4]\)
3. Verify Nozzle is 85mm from centre of Print Bed.
4. In case Nozzle is less than 85mm from centre of Print Bed, decrease value of 
   \#define DELTA_DIAGONAL_ROD \[\_\_\_\_\_\_\] shown in Step {H05}, or vice versa.
5. Reupload the updated Marlin_delta2 firmware as per procedure in {F10}
6. Repeat 1 to 5 till XY Plane’s dimension is as per defined (85mm)
7. Repeat 1 to 5 again with other XY Plane Print Boundaries at Coordinates 
   \([-85,0,0.4], [0,85,0.4] \text{ and } [0,-85,0.4]\). In theory, if the unit is built with 
   proper symmetry, they should be uniformly 85mm from the centre of Print Bed 
   as well.
Let’s Slice and Print

STL File Processing using Slic3r Software and GCODE File for First Test Print
Locate and run file [slic3r.exe] extracted during {F04}. In case Blomker KM Default not loaded as shown above, go to File-> Load Config… and load the file [Blomker KM Default Slic3r.ini] available in the extracted folder [Blomker KM Files]. This Config File is only meant to enable first test print for your Kossel Mini. Further tweaking needed if you have other printing requirements.

note : download ini here : https://www.dropbox.com/s/yss3q4dhrsxyva/kossel%20e3d.ini?dl=0
Locate file [10mm Calibration Cube.STL] in the extracted folder [Blomker KM Files]. Load the .STL file simply by drag and drop to Slic3r Print Plater. Dimension and Size info of the object are as shown above. Generate .GCODE file for test print by clicking “Export G-code” button.

[Load .STL file and Generate .GCODE for First Test Print]

note: download the stl here: http://www.thingiverse.com/thing:1/003/#files
Prepare PLA Filament

Straighten the filament end and taper off portion of the filament tip. This is to ensure smoother entry of filament thru the Extruder, Bowden tube and into the Hotend during filament feeding.
Feed the PLA Filament all the way into Hotend, either by using Pronterface GUI method shown in \{G04\}, or by hand feeding as shown above.
There is around 60-65mm of distance from the Push Fit Connector to the inner tip of brass Nozzle. The PLA Filament must be fully inserted into the Hotend, with the tip of Filament in contact with the...
Deploy Z Probe by Hand as recommended in {H09}. Pre heat Hotend to 215C as per similar procedure in {G05}. Allow molten PLA filament to drain from Nozzle before begin test print.
Once molten filament draining stops and Hotend able to sustain Temperature around 215C, loads .GCODE file generated in {I02} for test print. To start the test print, click “Print”. The G28 and G29 procedures are included in the .GCODE file during .GCODE generation using Blomker KM Default Slic3r settings.
10mm Calibration Cube printing in progress
In case dimensions of printed Calibration Cube are not accurate, refer to {H15} for dimension fine tuning procedures. In case fine-tuning of Steps per mm needed, it is recommended to recalibrate again from {H05} to {H15}.